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BAB III 

PERANCANGAN SISTEM 

 

A. Membuat Aplikasi Interaktif Dengan Flash Menggunakan Action 

Script 2.0  

1. Cara Membuat Background  

 Jangan lupa ketika membuat background pada photoshop ukurannya 

harus sama ketika membuat layar pada flash, misalnya dengan 

ukuran 800x600 pixel  

 

Maka akan menghasilkan seperti gambar di bawah  
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Setelah itu atur/ beri background sesuai dengan imajinasi anda 

 

 

 

Gambar 3.1 Flash 
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Ketika ingin mengimportkan file maka dengan cara 

File – import – import to library – lalu ambil file sesuai dengan yang 

di inginkan  

Jika ingin memunculkan file yang di ambil tadi melalui import to 

library maka tekan tombol ctrl+L , setelah itu tarik objek yang 

dikehendaki ke layar kerja. Jika gambar/ objek belum menengah 

maka tengahkan dengan menggunakan Align dan aktifkan to 

stage.pilih tombol yang di panah  

 

 

 

2. Cara Membuat Tobol  

Langkah atau cara membuat tombol yang pertama buatlah objek 

gambar/ huruf/ tulisan yang nanti akan di buat tombol. Pastikan 

ketika andamembuat tombol gunakan layer yang berbeda dengan 

layer background yang ada di atas tadi. 
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Klik objek tulisan – convert to simbol – pilih button - ok  

 

 

Jika sudah selesai maka setiaptombol yang sudah di bikin maka bisa 

di beri script dengan action script di bawah ini :  

Action Script 2.0 pada Macromedia Flash 

a. Script yang digunakan untuk membuat tombol link antar scene on 

(release) {gotoAndPlay("scene 1","3");  

}  

PENJELASAN  

// on (release) = Saat Mouse ditekan kemudia di lepaskan, // 

gotoAndPlay= Pergi menuju scen 1 dan frame 3  

b.  Script yang digunakan untuk membuat tombol colse on (release) 

 {  

fscommand("quit");  

}  

PENJELASAN  

// on (release) = Saat Mouse ditekan kemudia di lepaskan, // 

fscommand("quit") = command untuk keluar.  
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c.  Script yang digunakan untuk membuat fullscreen 

fscommand("fullscreen", "true");  

PENJELASAN // fscommand("fullscreen") = command untuk 

memberikan tampilan fullscreen 

 

B. Pengenalan Media Kerja Macromedia Flash 

1. Membuat file FLA dan menambahkan gambar 

Untuk membangun aplikasi dalam Flash CS4 Profesional, 

Anda membuat gambar vektor dan elemen desain dengan peralatan 

menggambar (Drawing Tool), dan impor tambahan elemen media 

seperti audio, video, dan gambar ke dalam dokumen 

Anda.Berikutnya, Anda menentukan bagaimana dan kapan Anda 

ingin menggunakan masing-masing unsur untuk menciptakan 

aplikasi yang ada dalam pikiran. 

Bila Anda penulis konten dalam Flash Profesional, Anda 

bekerja dalam sebuah dokumen yang disebut file FLA. FLA file 

mempunyai ekstensi file. Fla (FLA). Saat melihat file FLA, Anda 

akan melihat tampilan Flash CS4 Profesional (lihat Gambar 3.2) 

dibagi ke dalam lima bagian utama:  

 The Stage adalah tempat gambar, video, tombol, dan sebagainya 

muncul selama pemutaran.  

 The Timeline mengontrol waktu ketika unsur-unsur dalam film 

muncul pada Stage. Anda juga menggunakan Timeline untuk 
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menentukan urutan lapisan gambar pada Stage. Grafis dalam 

lapisan yang lebih tinggi muncul di atas grafis dalam lapisan 

yang lebih rendah.  

 Panel Toolsberisikan set alat umum yang digunakan untuk 

memilih objek-objek di panggung dan gambar vektor.  

 The Property inspector menampilkan informasi tentang objek 

yang dipilih bisa diedit.  

 The Library panel adalah tempat di mana elemen media dan 

simbol tersimpan dan terorganisir.  

 

Gambar 3.2 Tampilan Flash CS4 Profesional dibagi menjadi lima 

bagian utama  

 

ActionScript adalah kode yang memungkinkan Anda untuk 

menambahkan interaktivitas ke elemen media dalam dokumen 
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Anda.Sebagai contoh, Anda dapat menambahkan kode yang 

menyebabkan tombol untuk menampilkan gambar baru ketika 

pengguna mengklik sebuah objek.Anda juga dapat menggunakan 

ActionScript untuk menambahkan logika aplikasi Anda. Logika 

memungkinkan aplikasi Anda untuk berperilaku dengan cara yang 

berbeda tergantung pada tindakan pengguna atau kondisi yang 

berbeda. Flash CS4 Profesional menggunakan ActionScript 3.0 

ketika sebuah file ActionScript 3.0 atau Adobe AIR dibuat, atau 

ActionScript file 1.0 dan 2.0 ketika sebuah file ActionScript 2.0 

dibuat.  

Flash mencakup banyak fitur yang membuatnya hebat namun 

mudah digunakan, seperti prebuilt drag-and-drop pada komponen-

komponen tampilan, built-in motion effects yang dapat Anda 

gunakan untuk menghidupkan elemen pada Timeline, dan efek 

khusus yang dapat ditambahkan ke media objek.  

Bila Anda telah selesai mengerjakan file FLA Anda, Anda 

mempublikasikannya menggunakan File> Publish perintah (Shift + 

F12). Ini menciptakan sebuah versi kompresi file dengan ekstensi. 

Swf (SWF). Anda kemudian dapat menggunakan Flash Player untuk 

memainkan file SWF dalam sebuah web browser atau sebagai 

aplikasi yang berdiri sendiri.  
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2. Membuat file FLA sederhana  

Untuk menggambarkan langkah-langkah dasar menciptakan 

FLA setiap dokumen, tutorial ini memandu Anda melalui proses 

dalam sebuah tutorial sederhana. Tutorial singkat ini hanyalah 

contoh alur kerja yang akan Anda gunakan saat bekerja 

menggunakan Flash Professional. Langkah pertama adalah untuk 

membuat dokumen baru:  

a. Pilih File> New.  

b. Dalam kotak dialog New Document, Flash File (ActionScript 3.0) 

dipilih secara default. Klik OK.  

c. Klik menu drop-down ruang kerja pada bagian kanan atas layar 

dan pilih opsi Essentials tata letak ruang kerja (lihat Gambar 3.3).  

 

Gambar 3.3 Memilih pilihan Essentials untuk melihat tata letak 

ruang kerja yang digunakan oleh tutorial  

 

 

d. Klik tab Properties di sisi kanan atas tampilan untuk melihat 

Stage properti untuk file.  
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e. Dalam Property inspector, terletak secara default secara vertikal 

di sepanjang sisi kanan ruang kerja, tombol Ukuran menampilkan 

Tahap saat ini seperti pengaturan ukuran 550 × 400 piksel (lihat 

Gambar 3.4). Warna Background otomatis diatur ke putih.Anda 

dapat mengubah warna Stage dengan mengklik swatch atau palet 

warna dan memilih warna yang berbeda. 

 

Gambar 3.4 Property inspector Tahap menunjukkan ukuran dan 

warna background  
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f. Pilih File> Save.  

g. Pilih lokasi untuk file pada hard disk, beri nama file 

SimpleFlash.fla, kemudian klik Save. Ingat lokasi ini, karena 

Anda akan memerlukannya untuk menemukan direktori ini pada 

akhir tutorial ini.  

3. Menggambar sebuah lingkaran di Stage  

Setelah Anda membuat dokumen, Anda siap untuk 

menambahkan beberapa karya seni untuk dokumen:  

a. Pilih Oval tool dari panel Tools (lihat Gambar 3.5).  

 

Gambar 3.5 Oval tool dalam panel Tools  
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b. Klik stroke color swatch di Property inspector dan memilih No 

Color (tanpa warna) dari Stroke Color Picker (lihat Gambar 3.6).  

 

Gambar 3.6 Memilih opsi No Color (Tanpa warna) di Stroke 

Color Picker  

 

c. Select a color of your choice from the Fill Color Picker, located 

directly below the Stroke Color Picker. Make sure the fill color 

contrasts well with the Stage color. Pilih warna pilihan Anda dari 

Fill Color Picker, terletak tepat di bawah Stroke Color Picker. 

Pastikan warna Fill Color kontras dengan warna Stage. Dalam 

contoh ini, kami memilih Fill Color biru dengan warna Stage 

merah.  

d. Dengan Oval tool masih dipilih, gambarlah sebuah lingkaran di 

Stage dengan klik dan drag pada Stage (lihat Gambar 3.7). 
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Apabila dilakukan dengan menekan tombol Shift maka akan 

membuat bentuk lingkaran.  

 

Gambar 3.7 Lingkaran digambar di atas Stage  

 

4. Membuat simbol dan menambahkan animasi  

Anda dapat mengubah artwork baru Anda menjadi aset dapat 

digunakan kembali dengan mengubahnya menjadi sebuah 

simbol.Sebuah simbol adalah aset media yang dapat digunakan 

kembali di mana saja dalam dokumen Anda tanpa perlu membuatnya 

lagi.Simbol dapat berisi gambar dan animasi bersama dengan jenis 

konten lainnya. 
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a. Klik Selection tool pada panel Tools (lihat Gambar 3.8).  

 

Gambar 3.8 Panel Tools dengan Selection tool dipilih  

 

b. Klik lingkaran di Stage untuk memilihnya. Sebuah kotak seleksi 

muncul di sekitar lingkaran.  

c. Dengan lingkaran masih dipilih, pilih Modify> Convert to 

Symbol (atau tekan F8) untuk membuka kotak dialog Convert to 

Symbol (lihat Gambar 3.9).  

Catatan: Anda juga dapat mengkonversi gambar menjadi simbol 

dengan memilih dan menyeretnya ke dalam panel Library.  

 

Gambar 3.9 kotak dialog Convert to Symbol 
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d. Klik OK. Sebuah kotak persegi di sekitar lingkaran. Anda 

sekarang telah menciptakan aset yang dapat digunakan kembali, 

yang disebut simbol, dalam dokumen Anda. Dalam contoh ini, 

Anda membuat klip video simbol.  

e. Jika Library panel tidak muncul, pilih Window> Library. Simbol 

baru akan muncul dalam panel Library 

 

C.  Struktur TK “Dharma Wanita 2 Pelem” 

1. Gambaran Umum 

-   Nama TK   : TK Dharma Wanita 2 Pelem 

-   Alamat  : Desa Pelem Kecamatan Bungkal 

-   Berdiri  : Tahun 2013 

-   Mulai menerima anak didik : Tahun 2013 

  

No Nama Jabatan Pendidikan 
Status 

Pegawai 
Ket. 

1 
Herni 

Nurtanti 

Kepala 

Sekolah 
- - 

Mengikuti 

S1 PAUD 

2 
Siti 

Nurjanah 
Guru - - 

Mengikuti 

S1 PAUD 

 

Tabel 3.1 Keterangan Pengajar 

 

 

2. Kegiatan Belajar Mengajar 

 Tahun Ajaran 
Jumlah 

Keseluruhan 

Yang 

Tamat 
Keterangan 

2013 / 2014 14 4 - 

 

Tabel 3.2 Keterangan Siswa 
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Keterangan  

-   Jam pelajaran mulai pukul 07.30 pulang pukul 10.00 

-   Sistem pembelajaran menggunakan sistem rolling/area 

-  Tenaga pendidik/guru dituntut untuk kreatif, inovatif dan 

professional 

 

3. Sarana dan Prasarana 

a. Luas Bangunan Pekarangan 

b. Gedung 

-   Ruang Kantor  : 244 m
2
 

-   Ruang Tamu : 3,5 x 1,5 m
2
 

-   1 Ruang Kelas : 6 x 7 m
2
 

-   1 Kamar Mandi  : 3 x 1,50 m
2
 

-   Ruang Bermain : 13,5 x 3,5 m
2
 

c. Perabot 

-  Di dalam ruang kelas : 

Meja kursi anak, meja kursi guru, papan tulis, alat peraga 

yang diatur berdasarkan area. 

-  Di luar kelas : 

Jungkitan, ayunan dan peralatan olahraga lain seperti bola, 

dan lainnya.  

d. Perlengkapan kurikulum TK terdiri : 

-  Kurikulum TK nol kecil, nol besar 
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-  Program semester kelompok nol kecil, nol besar 

-  Program SKM 

-  SKH (Satuan Kerja Harian) yang ditanda tangani guru dan 

kepala TK 

-  Rangkuman penilaian 

-  Rapor 

-  Buku-buku petunjuk teknis lain yang mendukung. 

 

4. Manajemen TK  

a. Perencanaan 

Visi dan Misi TK DHARMA WANITA 2 PELEM adalah 

“Mencetak generasi cerdas, kreatif, mandiri, iman dan taqwa 

dan Misi TK DHARMA WANITA 2 PELEM adalah 

“Meletakkan dasar-dasar pendidikan secara proporsional, 

menyeluruh, seimbang, antara lahiriah dan batiniah, antara 

individu keluarga dan masyarakat”. 

 Untuk meningkatkan kualitas pembelajaran dilakukan 

dengan meningkatkan kualitas guru dengan mengikuti 

penataran, KKG, serta mengadakan studi banding ke TK yang 

lebih baik. 

b. Pelaksanaan 

Dalam pelaksanaannya dapat didiskripsikan sebagai 

berikut : 
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Kehadiran guru 90-100%, pertemuan rutin dengan Kepala 

Sekolah dalam satu semester 4-6 kali, kerjasama dengan tokoh 

masyarakat 2-3 kali dalam satu tahun, pertemuan dengan Dinas 

Pendidikan setahun 12 kali dan Kepala TK mengadakan 

evaluasi pembelajaran yang dilakukan oleh guru dalam setahun 

2 kali. 

c. Aspek Monitoring 

Aspek Monitoring dilakukan dengan cara sebagai berikut :  

Kepala TK membuat laporan bulanan/tahunan, laporan keadaan 

anak didik da kemajuan TK yang dipimpinnya ke Dinas 

Pendidikan, pengawas TK melakukan monitoring secara 

periodik. Instansi lain yang pernah memberikan penyuluhan 

adalah Dinas Kesehatan. 

 

5. Pembiayaan 

a. Sumber Dana  

Dana dari masyarakat/orang tua wali murid dalam bentuk uang 

sekolah sebesar Rp. 20.000 per bulan. 

b. Penggunaan Dana 

Dana dari orang tua/wali murid digunakan untuk meningkatkan 

kualitas guru, meningkatkan jumlah alat peraga dan KBM 

sehingga kualitas pembelajaran dapat meningkat secara 

berkelanjutan. 
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6.  Peran Serta Masyarakat 

Kegiatan yang dilakukan adalah mengadakan pertemuan antara 

orang tua dan guru dalam satu semester 
1
/2  kali dengan fokus 

pembahasan aspek perkembangan anaknya dalam mengikuti kegiatan 

belajar. 

Orang tua juga membantu guru dalam melengkapi alat 

pembelajaran dalam alat bentuk peraga. Selain itu, komite sekolah 

juga sudah membentuk keanggotaannya yang terdiri dari masyarakat 

dan orang tua. 

Tugas utama komite sekolah adalah perencanaan program 

pembelajaran dan penggalangan dana dalam rangka peningkatan 

kualitas pendidikan dan pengajaran yang berlangsung secara 

berkelanjutan. 

 

7.  Visi Misi dan Tujuan 

 Visi 

 Mencetak generasi yang cerdas, mandiri, iman dan taqwa 

 Misi 

 Meletakkan dasar-dasar pendidikan pra sekolah secara 

proporsional, menyeluruh, seimbang antara lahiriah dan batiniah 

antara, keluarga dan masyarakat. 

 Menanamkan ilmu pengetahuan dan teknologi. 
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 Memotivasi peserta didik untuk mandiri, disiplin, terampil, kreatif 

dan jujur. 

Tujuan 

 Menciptakan generasi yang beriman dan bertaqwa. 

 Mencetak generasi yang unggul dalam prestasi. 

 Mencetak generasi yag berakhlak mulia. 

 Mencetak generasi yang berguna bagi Nusa dan Bangsa.  

 Mencetak generasi yang berkualitas. 

  

D. Studi Kelayakan  

Studi kelayakan adalah suatu studi yang akan digunakan untuk 

menentukan kemungkinan apakah pengembangan proyek sistem 

multimedia layak diteruskan atau dihentikan. Studi kelayakan 

merupakan kepadatan, versi ringkasan dari keseluruhan analisis sistem, 

dan proses perancangan alpikasi multimedia untuk masing-masing 

penjelasan, analisis menyiapkan skedul penerapan secara kasar. 
1
 

Faktor-faktor yang mempengaruhi kelayakan adalah apakah 

sistem multimedia ini layak atau tidak, bergantung pada analisa 

kelayakan yang biasa disebut dengan analisa biaya dan manfaat. 

Analisa biaya dan manfaat ini menyangkut beberapa faktor, antara lain: 

 

 

                                                           
1
 M. Suyanto, Analisis & Desain Aplikasi Multimedia untuk Pemasaran , andi offset, Yogyakarta, 

2004, hal 53 
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1. Faktor Teknis 

Pertanyaan mendasar yang harus dijawab untuk menilai 

kelayakan adalah dapatkah sistem multimedia yang dibuat yaitu 

Pembelajaran Interaktif Matematika untuk Taman Kanak-kanak 

akan diterapkan menggunakan teknologi yang ada? 

Pada CD Pembelajaran Interaktif diatas menggunakan 

perangkat komputer untuk menjalankannya dari faktor teknis  

sehingga CD Pembelajaran Interaktif layak untuk digunakan.  

2. Faktor Ekonomi 

Pertanyaan mendasar yang harus dijawab untuk menilai 

kelayakan dari faktor ekonomi adalah dapatkah sistem multimedia 

yang dibuat yaitu Pembelajaran Interaktif Matematika untuk Taman 

Kanak-kanak dapat diterapkan tanpa harus mengeluarkan biaya 

yang besar? 

Dalam masalah biaya, CD interaktif ini tidak akan memakan 

biaya yang besar untuk membuatnya. Untuk menentukan proyek 

sistem multimedia tersebut layak atau tidak maka dilakukan 

perhitungan dengan metode analisis biaya dan manfaat.  

3. Faktor Operasi/Organisasi 

Pertanyaan mendasar yang harus dijawab untuk menilai 

kelayakan dari faktor operasional adalah dapatkah sistem 

multimedia yang dibuat yaitu Pembelajaran Interaktif Matematika 
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untuk Taman Kanak-kanak dapat diterapkan pada sistem yang 

berjalan? 

Pada CD interaktif tersebut tidak akan menganggu sistem 

yang sedang berjalan lainnya, karena CD interaktif tersebut berjalan 

sendiri, sehingga sistem yang lain tetap dapat berjalan sesuai 

dengan aturan yang ada. 

4. Faktor Hukum 

Pertanyaan mendasar yang harus dijawab untuk menilai 

kelayakan dari faktor hukum adalah dapatkah sistem multimedia 

yang dibuat yaitu Pembelajaran Interaktif Matematika untuk Taman 

Kanak-kanak tidak melanggar etika dan hukum? 

CD interaktif tersebut tidak akan melanggar hukum karena 

CD interaktif tersebut sudah dikemas sesuai dengan materi yang 

sudah ada dan tepat sasaran. Sistem informasi dan software yang 

diinstalkan legal untuk menjaga keamanan CD interaktif tersebut 

agar tidak melanggar hukum. 

5. Faktor Jadwal 

Pertanyaan mendasar yang harus dijawab untuk menilai 

kelayakan dari faktor jadwal adalah dapatkah sistem multimedia 

yang dibuat yaitu Pembelajaran Interaktif Matematika untuk Taman 

Kanak-kanak tidak ada kendala waktu? 

CD interaktif tersebut dirancang berdasarkan kurikulum yang 

sedang berjalan sehingga penggunaannya tidak akan kadaluarsa. 
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Selain materi yang dibuat bersifat ilmu pasti yaitu matematika. Jika 

ada perubahanpun akan dapat dilakukan dengan mudah.  

6. Faktor Strategik 

Pertanyaan mendasar yang harus dijawab untuk menilai 

kelayakan dari faktor strategik adalah dapatkah sistem multimedia 

yang dibuat yaitu Pembelajaran Interaktif Matematika untuk Taman 

Kanak-kanak dapat mempengaruhi strategi? 

Dengan penggunaan CD interaktif tersebut dapat merubah 

strategi baru dalam pembelajaran yang efektif atau tepat dan 

efisien. 

 

E. Metode Biaya-Manfaat 

Metode biaya-manfaat digunakan untuk menentukan apakah 

proyek sistem multimedia layak atau tidak. Biaya terdiri dari dua 

kategori, yaitu biaya yang berhubungan dengan pengembangan sistem 

multimedia dan biaya yang berhubungan dengan operasi (perawatan) 

suatu sistem multimedia. 
2
   

 

 

 

 

 

 

 

                                                           
2
 M. Suyanto, Analisis & Desain Aplikasi Multimedia untuk Pemasaran , andi offset, Yogyakarta, 

2004, hal 55 
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Tabel 3.3 Biaya manfaat 

No 
Rincian Biaya dan 

Manfaat 
Tahun ke-0 Tahun ke-1 Tahun ke-2 

1. 

 

 

 

 

2. 

3. 

Biaya pengadaan 

perangkat 

- Komputer 

- Penggandaan CD 

 

Biaya Perangkat Lunak 

Biaya Operasi/ 

Pemeliharaan 

- Hardware 

- Software  

 

 

 

6.250.000 

 

 

7.522.522 

 

 

 

4.540.000 

 

 

 

 

 

Garansi 

 

 

 

11.350.000 

 

 

 

 

 

500.000 

 Total Biaya (TB) 13.772.522 5.540.000 12.850.000 

 

Rincian Manfaat 

Manfaat Wujud 

- Penjualan CD 

 

 

1.000.000 

 

15.460.000 

1.000.000 

 

38.650.000 

 Total Wujud (TW)  15.460.000 38.650.000 

 Manfaat Tidak Wujud    

 
Total Tidak Wujud 

(TTW) 
   

 Total Manfaat (TM)  15.460.000 38.650.000 

  Proceed (Selisih TM dan TB)  9.920.000 25.800.000 

 

1. Metode Periode Pengambilan (Payback Periode) 

Metode ini menilai proyek investasi dengan dasar lamanya 

inventasi tersebut dapat kembali (tertutup) dengan aliran-aliran kas 

masuk tanpa memperhitungkan faktor bunga. Sehingga investasi 

dapat kembali (tertutup) dapat dihitung sebagai berikut .  

  Nilai Investasi   =Rp. 13.772.522,- 

  Proceed tahun 1  =Rp. 9.920.000 

  Sisa Investasi tahun 2 =Rp. 3.852.522,- 

  Perhitungan periode pengembalian sebagai berikut:  
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PP =    
000Rp.25.800.

22Rp.3.852.5
X 12 bulan = 1,79 bulan X 30 hari = 52,7 hari  

Dengan metode Payback Periode ini, maka investasi untuk 

penerapan sistem multimedia mencapai titik impas (Break Even 

Point) pada waktu 1 tahun 52,7 hari (1 bulan 23 hari). Sehingga pada 

tahun ke-2 bulan ke-2 sistem informasi telah memberikan 

keuntungan. 

 

2. Metode Pengembalian Investasi (Return On Investasi = ROI) 

Metode ini merupakan perbandingan prosentase manfaat yang 

dihasilkan oleh sistem tersebut dengan biaya yang dikeluarkan untuk 

penggandaan sistem tersebut. 

Adapun rumus untuk ROI dalam prosen adalah sbagai berikut :  

ROI = 
Manfaat  Total

 Biaya Total -Manfaat  Total
X 100% 

Dengan menggunakan rumus tersebut maka dapat dihitung 

Biaya pengadaan sistem tahun 0  =Rp. 13.772.522,- 

Biaya perawatan sistem tahun 1 =Rp. 5.540.000,- 

Biaya perawatan sistem tahun 2 =Rp. 12.850.000,-  

Total Biaya =Rp. 32.162.522,- 

Total keuntungan yang didapat adalah : 

Total Manfaat pada Tahun 1 =Rp. 15.460.000,- 

Total Manfaat pada Tahun 2 =Rp. 38.650.000,- 

Total Manfaat =Rp. 54.110.000,- 

+ 

+ 
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Sehingga dengan menggunakan rumus ROI didapat: 

ROI=
 32.162.522 Rp.

 32.162.522 Rp.-54.110.000Rp.
 X 100% =  68,2 % 

Artinya, sistem ini akan memberikan keuntungan pada tahun 

ke-2 sebesar 68,2 % dari biaya pengadaannya sehingga sistem ini 

layak digunakan.  

 

3. Metode Nilai Sekarang Bersih (Net Present Value = NPV) 

Metode ini merupakan metode yang memperhatikan nilai 

waktu dan uang dengan menggunakan bunga diskonto yang akan 

memperbaharui atau arus dari uangnya. Dengan metode ini, proyeksi 

nilai waktu dari uang akan diukur dngan faktor pembanding nilai 

bunga diskonto yang berlaku sehingga mempengaruhi total 

keuntungan. NPV dapat dihitung dari selisih nilai proyek pada awal 

tahun dengan total keuntungan dari tiap tahun yang dinilai uangkan 

ke tahun awal dengan tingkat bunga diskonto tertentu. Pada 

dasarnya, metode ini merupakan suatu gambaran jumlah keuntungan 

usaha sepanjang waktu tertentu yang diproyeksikan pada kondisi saat 

ini. 
3
 

NPV dapat dirumuskan sebagai berikut : 

NPV = - NI + 
 i)(1

nPROCEED

 i)(1

2PROCEED

 i)(1

 1PROCEED
n21 







 

  

                                                           
3
 M. Suyanto, Analisis & Desain Aplikasi Multimedia untuk Pemasaran , andi offset, Yogyakarta, 

2004, hal 56-57. 
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 NPV =   Net Present Value 

 NI     =   Nilai Proyek 

 i        =   Tingkat bunga diskonto diperhitungkan 

 n       =   Umur proyek 

Dengan rumus NPV tersebut maka diperoleh perhitungan sebagai 

berikut: 

NPV = - Rp. 13.772.522 +  
 20%)(1

25.800.000 Rp.

 20%)(1

 9.920.000 Rp.
21 




                          

 

NPV = - Rp. 13.772.522 + Rp. 8.266.666,67 + Rp. 17.916.666,7  

NPV = Rp. 12.460.811,- 

       Dari hasil perhitungan diatas, dapat disimpulkan bahwa 

jumlah keuntungan yang diterima dari pemakaian sisitem 

multimedia pada tahun ke-2 adalah sebesar Rp. 12.460.811,- 

dengan kata lain NPV > 0 dengan ketentuan tingkat bunga 

diskonto adalah 20% 
4
. Maka proyek tersebut layak 

dilaksanakan. 

       Hasil perhitungan dengan ketiga metode tersebut tercantum 

dalam tabel sebagai berikut: 

No 

Metode 

Biaya-

Manfaat 

Nilai Syarat Keputusan 

1 Payback 

Periode 

1 tahun 1 bulan 

23 hari 

< 2 tahun Layak 

                                                           
4
 Http://dudiwahyudi.com/pajak/pajak-penghasilan /pajak-penghasilan-atas-diskonto-

suratperbendaharaan-negara-spn.html 
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2 Return On 

Investasi 

68,2 % > 0 Layak 

3 Net 

Present 

Value 

Rp. 12.460.811,- > 0 Layak 

 

Tabel 3.4 Hasil Rincian Biaya-Manfaat 

 

F. Mendefinisikan Masalah 

Dalam pembuatan aplikasi multimedia, diperlukan pendefinisian 

masalah untuk mengidentifikasikan kebutuhan masyarakat dalam 

mendapatkan informasi yang menarik. Pembuatan rancangan aplikasi 

multimedia ini adalah untuk membantu murid Taman Kanak-kanak TK 

Dharma Wanita dalam memahami dan belajar pelajaran matematika 

serta membantu guru yang mengajar dalam menyampaikan materi.  

Berdasarkan latar belakang masalah di atas, maka dapat ditar ik 

pokok permasalahan sebagai berikut : 

“Bagaimana pembuatan CD Pembelajaran Interaktif Matematika untuk 

Taman Kanak-kanak dengan baik dan menarik?” 

 

G. Merancang Konsep 

Membangun suatu sistem dalam rencana kerja akan lebih mudah 

apabila telah memiliki konsep sehingga pekerjaan akan lebih terarah 

dan terkoordinir. Interaktif disini berarti pemakai dapat berinteraksi 
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secara langsung dengan aplikasi multimedia menggunakan tombol 

navigasi yang ada. Dalam pembuatan aplikasi berbasis multimedia ini, 

memadukan lima unsur penting multimedia, yaitu : teks, animasi, video, 

suara dan gambar. Dengan perpaduan kelima unsur tersebut   aplikasi 

ini akan lebih menarik dan lebih bervariasi sehingga menimbulkan 

minat. Pembuatan CD interaktif ini mempunyai konsep yang 

menjelaskan bagaimana belajar matematika dengan cara yang 

menyenangkan. 

 

H. Merancang Isi   

       Setelah tahap merancang konsep, selanjutnya adalah 

merancang isi multimedia. Dalam merancang isi multimedia ini, seluruh 

ide dan konsep dituangkan untuk membuat sistem multimedia ini. 

Perancangan isi diperlukan untuk memberikan kemudahan dalam 

penyampaian materi matematika untuk murid Taman Kanak-kanak TK 

Dharma Wanita melalui aplikasi multimedia interaktif. Caranya dengan 

membagi isi yang ada menjadi beberapa bagian, yaitu : 

1. Mengenal angka   :   materi dalam pengenalan angka 

2. Berhitung            :   belajar berhitung dengan soal matematika 

3. Mengenal Bentuk :   materi dalam pengenalan bentuk 

4. Mencocokkan     :   belajar mencocokkan bentuk dengan soal 

5. Video :   melihat kegiatan belajar pada TK Dharma 

Wanita 
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6. Keluar              :  menutup aplikasi 

Dalam perancangan aplikasi multimedia interaktif input 

multimedia dibedakan menjadi dua yaitu: visual dan audio. Input yang 

berupa visual seperti gambar-gambar akan dimasukkan dalam aplikasi 

menggunakan scanner dan CD-ROM, sedangkan input audio 

dimasukkan melalui CD-ROM, aplikasi ini bersifat interaktif, sehingga 

dalam pemilihan tampilan, penggunaan menggunakan mouse. Output 

visual muncul pada layar monitor dan output audio melalui speaker. 

  

I. Merancang Naskah 

Dalam pembuatan aplikasi ini dibutuhkan dialog antar elemen 

yang saling terkait dan dengan terinci, untuk lebih memudahkan 

pendekatan ini maka dibuatlah suatu diagram dan dengan alur diagram 

yang berupa stuktur hierarki, sehingga lebih jelas dan mudah dipahami. 

Penulisan naskah atau teks dalam aplikasi ini dibuat secara sistematis 

dan diurutkan menurut kategori masing-masing layar tampilan. Dengan 

menggunakan pendekatan diagram untuk mendesain aplikasi agar tiap 

tampilan dapat terbaca dan bisa menyediakan informasi maka 

disusunlah suatu struktur yang mengatur semuanya.   
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Keterangan : 

A. Loading 

B. Intro 

C. Menu Pembuka 

D. Menu Utama 

D1. Menu Mengenal angka 

D2. Menu Berhitung 

D3. Menu Mengenal bentuk 

D4. Menu Mencocokkan 

D5. Video 

D6. Keluar 

Gambar 3.10 Diagram Aplikasi 

A 

B 

C 

D 

D1 D2 D3 D4 D5 D6 
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Sketsa aplikasi: 

 

 

 

 

 

 

 

 

 

Gambar 3.3 Menu Loading 

 

 

 

  

Gambar 3.11  Menu Loding 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.12  Menu Intro 

 

 

 

 

Pembelajaran 

Interaktif untuk anak-anak “TK” 

Taman Kanak-kanak 

Animasi berjalan 



62 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Gambar 3.13  Menu Pembuka 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.14  Menu Utama 

 

 

 

 

 

 

 

Tombol ke Menu Utama 

Mengenal angka Mengenal bentuk Berhitung 

Mencocokkan 

Keluar 
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 Gambar 3.15  Menu Mengenal Angka  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.16 Menu Berhitung 

 

 

 

 

 

 

 

Animasi angka-angka 

Tombol mute 
Ke Menu Utama 

Ke Menu Utama 

Tombol 

-tombol 

angka 

Soal-soal berhitung 

Animasi bergerak 
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Gambar 3.17  Menu Mengenal Bentuk  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.18 Menu Mencocokan 

  

 

 

 

Ke Menu Utama 

Tombol mute 

Animasi bentuk 

Tombol ke soal-soal 

Animasi bentuk-bentuk berjalan 

Ke Menu Utama 
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Gambar 3.19 Menu Soal Mencocokkan 

 

 

 

J. Merancang Grafik 

Perancangan grafik dilakukan untuk membuat kerangka yang 

akan digunakan untuk menampilkan aplikasi program. Disini akan 

dimasukkan beberapa efek seperti suara, gambar dan animasi yang 

digabungkan menjadi satu sehingga akan dijalankan nantinya.  

Desain program aplikasi untuk pembelajaran interaktif ini 

didesain atau dirancang dengan menggunakan Macromedia Flash 8 pro, 

efek suara dengan Adobe Audition 1.5, background dan pengeditan 

gambar-gambar dengan menggunakan Adobe Photoshop CS2 dan 

CorelDRAW 12.  

 

 

Soal-soal mencocokkan 

Tombol-tombol bentuk 

Ke Menu Utama 


